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Abstract
Wireless control system is a cost-effective solution 
for a wide range of control applications. It has 
become a necessity with use in devices like remote 
controls, remote metering, wireless alarm, gate 
control, and system wireless control devices. 

Zilog’s Wireless Zdots® Single Board Computer 
(SBC) serves as a web-based control system, 
capable of wirelessly hosting a Web page. Wireless 
Zdots SBC module runs a TCP/IP stack over the 
wireless channel that can be used to control several 
applications via a wireless Internet application.

This Application Note demonstrates how you can 
add a custom Web page with virtual buttons which 
act as real buttons when connected to Wireless 
Zdots SBC hardware or an external link. The 
Wireless Zdots SBC serves as an added tool in
controlling distant devices with the use of Internet.

This application is developed using
ZDS II v4.11.1 and ZTP v2.2.0. The
source code file associated with this
A p p l i c a t i o n  N o t e ,  AN0298-
SC01.zip, is available for 
download at www.zilog.com.

Product Overview
This section provides a brief overview of Zilog’s 
eZ80AcclaimPlus!™ MCU, Wireless Local Area 
Network (WLAN), Wireless Zdots SBC, and ZTP 
under the following headings:

• eZ80AcclaimPlus!TM MCU Overview
• WLAN Overview
• Wireless Zdots® SBC Overview
• Zilog TCP/IP Software Suite Overview

eZ80AcclaimPlus!TM MCU Overview
At the center of Wireless Zdots SBC is award 
winning eZ80AcclaimPlus! Microcontroller, 
featuring a powerful 50 MHz single-cycle instruc-
tion fetch eZ80® core with 24-bit ALU, 256 KB of 
embedded Flash, 16 KB of SRAM as well as a 
variety of peripherals including six 16-bit timers, 
32 GPIO, 2 UARTs, 1 SPI, 1 I2C and support for up 
to 16 MB of external memory. In addition, the 
eZ80AcclaimPlus! Wireless Zdots SBC boasts an 
additional 4 MB of NOR Flash,1 MB of SRAM, 
and 2 MB of serial Flash.

WLAN Overview
Wireless Local Area Network (WLAN) enables the 
computers and devices to send and receive the data 
within the range of a wireless base station. There 
are few WLAN standards, the newest ones being 
backwards compatible to older standards. These 
are defined by the Institute of Electrical and 
Electronics Engineers (IEEE): 802.11b, 802.11g 
and 802.11a. The WLAN standards 802.11 allow 
data transmission up to 2 Mbps. These extensions 
are recognized by the addition of a letter to the 
original 802.11 standard, including 802.11a and 
802.11b. The 802.11b specification operates at 
radio frequencies in the 2.4 GHz to 2.497 GHz 
bandwidth of the radio spectrum. 

The modulation method selected for 802.11b is 
known as complementary Direct Sequence Spread 
Spectrum (DSSS) using Complementary Code 
Keying (CCK) making data speeds as high as 
11 Mbps. The 802.11a operates at radio frequen-
cies between 5.15 GHz and 5.875 GHz and a 
modulation scheme known as Orthogonal 
Frequency Division Multiplexing (OFDM) makes 
data speeds as high as 54 Mbps possible.
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The most common and widespread wireless
networking products are compatible with the 
802.11b standard, working in the 2.4 GHz band 
with a data-transfer rate of up to 11 Mbps.

Wireless Zdots® SBC Overview
Zilog’s eZ80AcclaimPlus! Wireless Zdots SBC 
delivers a complete Wireless solution that can be 
easily and quickly embedded into various devices 
to enable Wireless capability. This fully integrated 
Wireless Zdots SBC offers a rich hardware feature 
set along with a full, royalty free, web-server soft-
ware stack, thus, making your Wireless solution 
development quick, efficient, and cost-effective.

Zilog TCP/IP Software Suite 
Overview 
The Zilog TCP/IP (ZTP) integrates a rich set of
networking services with an efficient real-time
operating system (RTOS). The operating system is
a compact preemptive multitasking, multi-
threaded kernel with inter-process communica-
tions (IPC) support and soft real-time attributes.
Table 1 lists the standard network protocols imple-
mented as part of the embedded TCP/IP protocol
stack in ZTP.

Many TCP/IP application protocols are designed
using the client-server model. The final stack size
is link-time configurable and determined by the
protocols included in the build.

Discussion
This section provides a discussion on how to build 
a Web page. 

Building Your Web Page
The Project Viewer in ZDS II contains the directo-
ries of all the source files, dependencies, and web 
files in the project. The web files are added to the 
appropriate folder in the AN0298-SC01.zip 
directory. For this Application Note, the webserver 
demonstration project used is the web-
site.zdsproj. To include Web page files in the 
project, or to change a set of Web pages in the 
project, the current Acclaim_Website.lib 
file must be removed or updated from the project.

All the files are placed and linked to a Web page, 
including java applets and CGI functions in the 
AN0298-SC01.zip directory. Table 2 provides 
the samples of these filename extensions. The web 
files in the AN0298-SC01.zip directory must 
follow the correct directory format as displayed in 
Figure 1 on page 3.

After rebuilding the project, the resulting execut-
able file contains web pages appropriate to the 
project. Files in the Web files directory are 
removed during the build, and a new 
Acclaim_Website.lib file is generated in the 
source file directory. This library includes struc-
tures of the type static page for each Web page, and 
these structures are identified with a name that is 
derived from the name of each web file.

Table 1. Standard Network Protocols in ZTP

HTTP TFTP SMTP Telnet IP PPP SSL

DHCP DNS TIMEP SNMP TCP UDP

ICMP IGMP ARP RARP SNTP FTP

Table 2. Web Page Filename Extensions

File Name Extension
Web Pages .htm, .html

CGI Functions .c

Applet Classes .class

Image Files .jpg, .gif
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HTTP is interfaced with the Zilog File System. As 
a result, web pages can be uploaded to the eZ80® 
CPU at run-time using either TFTP or FTP. All the 
web files to be uploaded to the directory must be 
specified by using the following statement in the 
ZTPConfig_Wlan.c file: 

INT8 httppath[] = "/" 

HTTP first searches for the requested Web page in 
the static website array. If this Web page is not 
found in the static array, it searches in the directory 
specified by the INT8 httppath[] variable. 
For web files added to the Zilog File System, the 
Content type field in the HTTP reply is filled 
based on the file extension used. A standard map-
ping of a file extension to its content type is main-
tained in a structure that is defined in website.c 
file, located in the following path: 

\ZTP\SamplePrograms\website

The website.c file is listed in the following 
code fragment, which includes a definition for the 
mimetypes[] structure.

struct mimetype 
{/* file extensions */ 
INT8 * fileExtns; 
/* Associated mime types for the file 
extensions */ 
INT8 * type;
};
struct mimetype mimetypes[] = 
{ 
{".htm","text/html"}, 
{".html","text/html"}, 
{".jpg","image/jpg"}, 
{".class","application/octet-stream"}, 
{".gif","image/gif"},
// If the file extensions does not match 
any then 
// unknown will be used.
// This should always be at the end. 
{"unknown","unknown"}
};

The last statement of the website.c file should 
always be {"unknown","unknown"}. The 
structure of this file can be updated with additional 

file extensions and their MIME types. If this struc-
ture is updated, then the website library must be 
rebuilt to reflect the updated elements.

Developing Application with 
Wireless Zdots® SBC
This section discusses the implementation of the 
Wireless Zdots SBC as a web-based control 
system using Wireless Zdots SBC module.

Adding Web Page Demo
The Demo described in this Application Note 
requires the Wireless Zdots SBC (with the 
eZ80F91 eZ80AcclaimPlus!TM MCU) and the ZTP. 
For the Demo execution, some of the files specific 
to the Demo must be added and integrated to the 
ZTP stack before it is downloaded onto the
Wireless Zdots SBC.

The Demo files that must be added to the ZTP 
project files are in the AN0298-SC01.zip file, 
available for download at www.zilog.com. Figure 1 
displays the directory structure of the sample Web 
page. 

Figure 1. Directory structure of a Sample 
Web Page

The ZTP v2.2.0 stack (available for download at 
www.zilog.com) can be downloaded with a user 
registration key. ZTP can be installed in any loca-
tion as specified by you. By default, ZTP is 
installed in below path:

C:\Program Files\ZiLOG
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To add and integrate the Web page Demo files to 
the ZTP stack, perform the following steps:

1. Download and install ZTP v2.2.0. Browse to
the location where ZTP is installed, and open
the below folder:
..\Program Files\ZiLOG\
ZTP_2.2.0_Lib_ZDS\ZTP\
SamplePrograms

2. Download the AN0298-SC01.zip file. 
Extract and copy website.WLAN folder and 
its contents to the below folder:
..\ZTP_2.2.0_Lib_ZDS\ZTP\SamplePr
ograms 

3. Launch ZDS II—eZ80Acclaim! v4.11.1, and 
open the website.zdsproj project file 
available in the below path: 
..\ZTP\SamplePrograms\website.WLA
N

4. Add the *.png and *.swf files to 
ZDS II by selecting Tools → Options → File 
Types tab. In the Associated File Types field, 
type the file extensions to store in the new 
directory. Use a comma to separate the file 
types. Click OK.

5. Add the Web page files (listed in Table 3) to 
the project by selecting Add Files from 
Project menu. When Add files to Project 
dialog box is displayed, navigate to the direc-
tory containing the web pages *.htm, 
*.jpeg, *.class, *.png and *.swf file 
types.

Table 3. Web Page Files

/website.WLAN /website.WLAN/image 
Folder

cgi.htm acclaimheading.jpg

contactus.htm logo.jpg

demos.htm leadfree.jpg

ez80f91.htm devkit.jpg

ez80f92.htm /website.WLAN/swf Folder

ez80.htm ez80.swf

javaapplets.htm /website.WLAN/buttons 
Folder

javascripts.htm button1over.png

lake.class button1up.png

main.htm button2over.png

overview.htm button2up.png

products.htm button3over.png

siteinfo.htm button3up.png

siteinfopage.htm button4over.png

tcpip.htm button4up.png

webpagedemo.htm button5over.png

button5up.png

Table 3. Web Page Files (Continued)
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6. Open the website.c file of the website project and add the following structure definition for the 
included web files with the filename.extension → filename_extension format.

//website.WLAN
extern const struct staticpage cgi_htm;
extern const struct staticpage contactus_htm;
extern const struct staticpage demos_htm;
extern const struct staticpage ez80f91_htm;
extern const struct staticpage ez80f92_htm;
extern const struct staticpage ez80_htm;
extern const struct staticpage javaapplets_htm;
extern const struct staticpage javascripts_htm;
extern const struct staticpage Lake_class;
extern const struct staticpage main_htm;
extern const struct staticpage overview_htm;
extern const struct staticpage products_htm;
extern const struct staticpage siteinfo_htm;
extern const struct staticpage siteinfopage_htm;
extern const struct staticpage tcpip_htm;
extern const struct staticpage webpagedemo_htm;
//website.WLAN/image
extern const struct staticpage acclaimheading_jpg;
extern const struct staticpage logo_jpg;
extern const struct staticpage leadfree_jpg;
extern const struct staticpage devkit_jpg;
//website.WLAN/swf
extern const struct staticpage ez80_swf;
//website.WLAN/buttons
extern const struct staticpage button1over_png;
extern const struct staticpage button1up_png;
extern const struct staticpage button2over_png;
extern const struct staticpage button2up_png;
extern const struct staticpage button3over_png;
extern const struct staticpage button3up_png;
extern const struct staticpage button4over_png;
extern const struct staticpage button4up_png;
extern const struct staticpage button5over_png;
extern const struct staticpage button5up_png;

The Object Librarian for ZDS II IDE will generate a C file equivalent to the added web
pages in the file.extension → file_extension.c format.

7. Add the following mimetype to the website structure array that will define the content type of the 
added files:
Webpage website[] = {
//website.WLAN/root
{HTTP_PAGE_STATIC, "/", "text/html", &main_htm },
{HTTP_PAGE_STATIC, "/cgi.htm", "text/html", &cgi_htm },
{HTTP_PAGE_STATIC, "/contactus.htm", "text/html", &contactus_htm },
{HTTP_PAGE_STATIC, "/demos.htm", "text/html", &demos_htm },

Note:
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{HTTP_PAGE_STATIC, "/ez80f91.htm", "text/html", &ez80f91_htm },
{HTTP_PAGE_STATIC, "/ez80f92.htm", "text/html", &ez80f92_htm },
{HTTP_PAGE_STATIC, "/ez80.htm", "text/html", &ez80_htm },
{HTTP_PAGE_STATIC, "/javaapplets.htm", "text/html", &javaapplets_htm },
{HTTP_PAGE_STATIC, "/javascripts.htm", "text/html", &javascripts_htm },
{HTTP_PAGE_STATIC, "/Lake.class", "application/octect-stream", &Lake_class 
},
{HTTP_PAGE_STATIC, "/main.htm", "text/html", &main_htm },
{HTTP_PAGE_STATIC, "/overview.htm", "text/html", &overview_htm },
{HTTP_PAGE_STATIC, "/products.htm", "text/html", &products_htm },
{HTTP_PAGE_STATIC, "/siteinfo.htm", "text/html", &siteinfo_htm },
{HTTP_PAGE_STATIC, "/siteinfopage.htm", "text/html", &siteinfopage_htm },
{HTTP_PAGE_STATIC, "/tcpip.htm", "text/html", &tcpip_htm },
{HTTP_PAGE_STATIC, "/webpagedemo.htm", "text/html", &webpagedemo_htm },
{HTTP_PAGE_DYNAMIC, "/cgi-bin/increment", "text/html", (struct staticpage 
*)increment_cgi },
//website.WLAN/image
{HTTP_PAGE_STATIC, "/image/acclaimheading.jpg", "image/jpg", 
&acclaimheading_jpg },
{HTTP_PAGE_STATIC, "/image/logo.jpg", "image/jpg", &logo_jpg },
{HTTP_PAGE_STATIC, "/image/leadfree.jpg", "image/jpg", &leadfree_jpg },
{HTTP_PAGE_STATIC, "/image/devkit.jpg", "image/jpg", &devkit_jpg },
//website.WLAN/swf
{HTTP_PAGE_STATIC, "/swf/ez80.swf", "unknown", &ez80_swf },
//website.WLAN/buttons
{HTTP_PAGE_STATIC, "/buttons/button1over.png", "unknown", &button1over_png 
},
{HTTP_PAGE_STATIC, "/buttons/button1up.png", "unknown", &button1up_png },
{HTTP_PAGE_STATIC, "/buttons/button2over.png", "unknown", &button2over_png 
},
{HTTP_PAGE_STATIC, "/buttons/button2up.png", "unknown", &button2up_png },
{HTTP_PAGE_STATIC, "/buttons/button3over.png", "unknown", &button3over_png 
},
{HTTP_PAGE_STATIC, "/buttons/button3up.png", "unknown", &button3up_png },
{HTTP_PAGE_STATIC, "/buttons/button4over.png", "unknown", &button4over_png 
},
{HTTP_PAGE_STATIC, "/buttons/button4up.png", "unknown", &button4up_png },
{HTTP_PAGE_STATIC, "/buttons/button5over.png", "unknown", &button5over_png 
},
{HTTP_PAGE_STATIC, "/buttons/button5up.png", "unknown", &button5up_png },
{0, NULL, NULL, NULL } };

8. Build the project. The Acclaim_Website.lib gets generated in the same directory as the project. 
Copy and overwrite the existing library file to the following location:
..\ZiLOG\ZTP_2.2.0_Lib_ZDS\ZTP\Lib

9. Close the website.zdsproj project.
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Demonstrating the Application
This section describes the equipment used, setup, 
and procedure followed to host a Web page 
through Wireless Zdots® SBC module.

Equipments Used
The equipment used for demonstrating the Web 
page demo application include:

Hardware
• eZ80acclaimPlus!TM Wireless Zdots SBC 

Development Kit (eZ80F91WF01ZCOG). 
This development kit contains Wireless Zdots 
SBC Module and eZ80® Wireless Zdots SBC 
Board

• Wireless Access Point (WAP)

Software
• Zilog Developer Studio II (ZDS II) IDE 

v4.11.1 for eZ80Acclaim!® devices
• Zilog’s TCP/IP stack (ZTP) v2.2.0 
• Windows-based PC with the HyperTerminal 

application

System Configuration
The HyperTerminal application settings are 
provided below:

• Serial Port: COM1 or COM2

• Baud Rate: 57600 bps

• Parity: None

• Data Bits: 8

• Stop bit: 1

• Flow Control: None

Setup
Install eZ80F91 eZ80Acclaim! development kit as 
indicated in the eZ80F91 Development Kit User 
Manual (UM0142). Unplug the power supply and 
remove the eZ80F91 module.

Figure 2 displays the hardware setup for the 
WLAN application that is used to demonstrate 
Wireless Web page demo application.

Figure 2. Hardware Setup for WLAN Application
AN029801-1208  Page 7 of 11



Adding Custom Web Page for your Wireless Zdots® SBC
To set up the Hardware, perform the following 
steps: 

1. Connect Zdots® SBC to J1 of the Wireless base 
board. The SBC must be connected before 
applying the power.

2. Connect the RS-232 adapter (99C1067-001G) 
to the WLAN Zdots SBC J3 header.

3. Connect the USB Smart cable (or any Zilog 
Debug tool) to the 6-pins ZDI interface on the 
Wireless Base Board on your development PC.

4. Connect the RS-232 cable to the RS-232 
adapter P1 connector and the other end to the 
communication port (COM1) of the PC.

5. Connect the power supply (5 V DC) cable to 
the Wireless Base board J4 connector.

6. Set up an Access Point (AP) in the test area 
and power it ON.

Procedure
Configuring the HyperTerminal Application
You must first configure the HyperTerminal 
application before starting the demo application. 

To configure the HyperTerminal application,
perform the following steps: 

1. Launch the HyperTerminal application by nav-
igating to Start → Programs → Accessories
→ Communications → HyperTerminal. The
Connection Description dialog box is 
displayed. 

2. Enter a name for a new connection in the Con-
nection Description dialog box, and click 
OK. The Connect To dialog box is displayed. 

3. In the Connect using text field, select the port 
(COM1 or COM2) to which the serial cable is 
connected and click OK. The Port Settings 
dialog box appears for the selected port. 

4. In the Port Settings dialog box, select the 
values in the respective text fields (see System 
Configuration on page 7).

5. Click OK. The connection to the eZ80® 
development platform via the serial port is 
established. 

Running the Web Page Demo Project
The Web page demo initializes the appropriate 
device drivers of the WLAN interface. It sends the 
probe request to the configured Service Set Identi-
fier (SSID), receives response from the specified 
SSID only, and also joins the same Basic Service 
Set Identifier (BSSID). Using the ZTP WLAN 
demo, you can browse the web pages on the resi-
dent HTTP server, and use Telnet server/client.

To execute the Web page demo project in the 
ZDS II development environment, perform the 
following steps:

1. Set up the hardware as displayed in
Figure 2 on page 7.

2. Launch ZDS II by navigating to Start → Pro-
grams → ZiLOG ZDS II - eZ80_<Version> 
_ZDS II-eZ80_<Version>. 

3. Select Open Project from the File menu and 
open the sample ZTP demo project located in 
the below path: 
<ZTP Installed 
Dir>\ZTP_2.2.0_Lib_ZDS\ZTP\Sample
Programs\WLANDemo\WLANDemo.zdspro
j> 

4. Select Set Active Configuration from the 
Build menu. The Select Configuration dialog 
box is displayed. Select the RAM configura-
tion as shown below and applicable for this 
Application Note:

RAM Configuration:
RANGE ROM: 0-8FFFF
RANGE RAM: 90000-FFFFE

FLASH Configuration:
RANGE ROM: 0-3FFFF, 100000-4FFFFF
RANGE RAM: C00000-CFFFFF

COPY_TO_RAM Configuration:
RANGE ROM: 0-3FFFF, 100000-1FFFFF
RANGE RAM: C00000-CFFFFF
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5. Select Settings from the Project menu. The 
Project Settings dialog box is displayed. In 
the Project Settings dialog box, select the 
Debugger tab. In the Debugger tab, ensure 
that eZ80F91_WiFi_RAM option is checked. 

6. Click OK to close the Project Settings dialog 
box. 

If the ZDS II prompts to Rebuild the 
Project, click YES to enable the 
configuration on Project → 
Settings.

7. After the successful build, run the Demo 
application using Debug → Go.

8. Once the shell prompt appears, use the scan 
command on the Hyper Terminal window and 
press Enter to search the access points (AP) 
available in the range. Then use the join 
<SSID> <WEPKEY> shell command and press 
Enter to connect to a specified AP.

For more details on shell commands, refer to
Zilog TCP/IP Software Suite Programmer’s
Guide (RM0041).

9. After successful connection to the BSS (AP) 
the network stack will be initialized and 
Zdots® SBC behaves as a complete wireless 
station. 

1. To support FLASH and COPY_TO_RAM con-
figuration on Wireless Zdots SBC (due to new
external SPANSION Flash) ZDS II Flash
driver configuration file must be modified.
Replace the FlashDevice.xml file in the
...\ZDSII_eZ80Acclaim!_4.x.x\con-
fig folder with the file given in the WLAN-
Demo folder. In the Project → Settings →
Debugger; eZ80F91_WiFi_Flash must be
selected for FLASH and COPY_TO_RAM con-
figurations. After replacing the FlashDe-
vice.xml file close all ZDS II instances and
reopen again.

2. By default the wlan_conf.c file contains 
WLAN parameters set to zero. In this case, you 
can configure these parameters through shell 
and connect to a BSS (AP).

3. If the WLAN parameters in wlan_conf.c are 
valid (that is, not initialized to NULL), the 
Demo connects to the specified BSS (AP) with-
out the user 
interaction.

4. In FLASH and COPY_TO_RAM configura-
tions the SSID and WEP key can be set through 
the configwlan shell command. For more 
details, refer to Zilog TCP/IP Software Suite 
Programmer’s Guide (RM0041).

5. The Zdots® WLAN solution 
cannot be configured to work as an Access 
Point.

Demonstration
When you run the Web page demo application, 
Zdots SBC joins the BSS with the specified SSID 
and displays the network parameters and a login 
prompt on the HyperTerminal application. You can 
type help on the command prompt to know other 
command line applications. 

To browse the Web page embedded on Wireless 
Zdots SBC, perform the following steps:

1. Use PING command from any PC present in
the same BSS or ESS to eZ80® Wireless Zdots
SBC Board running ZTP. You can also ping
from Zdots SBC shell to other PC as well.

2. Open Internet Explorer from PC or a laptop 
and browse to the eZ80® Wireless Zdots SBC 
with the IP specified on the console output 
(see Figure 3 on page 10).

3. You can access the eZ80® Wireless Zdots SBC 
Board through Telnet by a PC or a laptop and 
its shell prompt through a wireless connection.

Note:

Notes:
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Figure 3. IP Address Example

Figure 4. Static Web Page Demo with Link Buttons to External Websites

Summary
This Application Note (using Wireless Zdots® 
SBC) demonstrates a wireless web-based control, 
which directs the users to an external link (Inter-
net). This embedded application can be configured 
to the style, look, and interface you wish to use 
depending on your application. It also allows you 
to control several wireless applications when con-
figured to interface from a hardware that is con-
nected to the Wireless Zdots SBC module. They 
can turn ON and OFF to a certain device, log, and 
capture the data. This module can also replace the 
existing wired control applications.

References
The documents associated with ZTP, 
eZ80AcclaimPlus!TM Wireless Module, and 
Wireless Zdots SBC available on www.zilog.com 
are provided below:

• Zilog TCP/IP Software Suite Programmer’s 
Guide (RM0041)

• Wireless Zdots® Single Board Computer 
Development Kit Quick Start Guide (QS0075)

• eZ80AcclaimPlus!TM Wireless Zdots® Single 
Board Computer Product Specification 
(PS0280)

• Wireless Zdots® Single Board Computer 
Development Kit User Manual (UM0224)
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SUPPORT DEVICES OR SYSTEMS WITHOUT THE EXPRESS PRIOR WRITTEN APPROVAL OF
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